Honeywell

Honeywell Software
Licensing Portal

User Guide



Disclaimer

WARNING

Honeywell International Inc. (“HII”) reserves the right to make changes in specifications and
other information contained in this document without prior notice, and the reader should in
all cases consult HIl to determine whether any such changes have been made. HIl makes no
representation or warranties regarding the information provided in this publication.

CAUTION

HIl shall not be liable for technical or editorial errors or omissions contained herein; nor for
incidental or consequential damages resulting from the furnishing, performance, or use of
this material.

This document contains proprietary information that is protected by copyright. All rights are
reserved. No part of this document may be photocopied, reproduced, or translated into another
language without the prior written consent of HIl.

©2024 Honeywell International Inc. All rights reserved.
Web Address: https://automation.honeywell.com

Microsoft, Windows, Azure, and Linux are trademarks or registered trademarks of their
respective owners.

Patents

For patent information, please refer to https://hsmpats.com.
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CHAPTER

INTRODUCTION

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be configured
to allow pop-ups.

The Honeywell Software Licensing Portal (HSLP) is the mechanism for delivering licenses for
VoiceConsole 6.2 and later.

HSLP is used by:

e Direct customers - Customers who have purchased their Voice Solution directly
from Honeywell. These customers manage their own license deployment within the HSLP.

e Partners - Partners who are providing a Voice Solution to their end customers. Partners
manage licenses for their end customers and provide these licenses to their end
customers.

° The partner may choose to handle all licensing functions for their customer within
the Honeywell Software Licensing Portal. In this case, only partners have access to
HSLP.

° The partner may choose to have their end customers register as limited access users
with the Honeywell Software Licensing Portal, allowing the customer to activate their
license without partner assistance. Partners must share the HSLP link and the
Entitlement ID with their end customer. The end customer must have this
information to register with HSLP.

NOTE

If you bought your Honeywell Voice Solution through a partner, the partner provides the
licensing information to you. Details are included in VoiceConsole online help:
https://help.honeywellaidc.com/Software/VoiceConsole/Content/Console_Home.htm.

HSLP users receive license updates via email, and can view entitlement and Activation IDs per
purchase order, and activate and deactivate licenses.

HSLP is used to license VoiceConsole 6.2 and later. Earlier versions of VoiceConsole continue to
use Honeywell legacy licensing. Legacy licensing is delivered outside of HSLP.
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The following deployment types are used throughout this document. it is important to know
which deployment used as it affects the processes in HSLP.

VoiceConsole SaaS deployment: VoiceConsole managed by Honeywell as a Cloud-only
solution. These deployments use cloud licensing.

VoiceConsole On Prem deployment: VoiceConsole installed within a customer-managed
environment. That environment can be a local server or a customer-managed cloud
environment. These deployments use a local licensing server.

Refer to the following sections for details on using the Honeywell Software Licensing Portal.

User Accounts - This section contains details on accessing the Honeywell Software
Licensing Portal for new and existing users as well as user account management.

Devices - This section contains details on the devices within the Honeywell Software
Licensing Portal. These devices may be Cloud Licensing server, Local Licensing Servers,
and (for Cloud Licensing only) the connected and licensed voice devices Served Devices).
Details on using the search feature are included.

List Entitlements - This section details the entitlements and Activation IDs associated with
the account. Details on using the search feature are also included.

License Management - This section details the process of activating the license in
VoiceConsole. Procedures are details for SaaS deployments with a Cloud Licensing Server
and On Prem deployments with a Local Licensing Server.

HSLP Access Troubleshooting - This section contains help if you have trouble logging in to
the Honeywell Software Licensing Portal.

HSLP Common Questions and Procedures - This section details common procedures you
may wish to perform in the Honeywell Software Licensing Portal and frequently asked
guestions about using the portal.

The terms below are used throughout this document. Certain terms may have different
meanings within the context of the Honeywell Software Licensing Portal than they may in other
Honeywell Voice documentation.
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Definition

Activate License

Activation ID
(License Key)

Add On license

Canceling
License

Cloud Server ID

Deactivate or
Return License

Device

The process to make a license available to consume with the specified
quantity

The Activation ID is used to activate VoiceConsole On Prem deployment
based licenses. For each Purchase Order (PO) submitted, you receive a
new Activation ID via email which includes the quantity of licenses
purchased.

An add on license is when a customer purchases more or subsequent
licenses. The Activation ID (license) adds more of the same licenses to an
existing Entitlement.

Canceling a license means the customer no longer "owns" that license.
Canceling is irreversible. After canceling an Activation ID all configurations
are deleted.

Used to activate VoiceConsole SaaS deployment licenses. For each
Purchase Order (PO) submitted, you receive a new Activation ID but keep
the Cloud Server ID remains the same throughout life of entitlement. Youl
receive instruction via email to refresh VoiceConsole SaaS deployment
using the Server ID to bring in latest features. For each Ship To there is a
unique Cloud Server ID

The process to return a license from one instance of VoiceConsole.
Deactivating a license makes it available in HSLP to be re-activated on the
same or another VoiceConsole instance belonging to same customer.

This feature is applicable to VoiceConsole On Prem deployments only.
There are three categories of devices that can be found in the Honeywell
Software Licensing Portal:

e Local License Server: These deceives are listed by the MAC address
of the Local Licensing Server for VoiceConsole On Prem
deployments.

* Cloud License Server: These devices are listed by the Cloud Server ID
for VoiceConsole SaaS deployments.

e Servers Device- These are the Voice devices (A700x and Android
devices) that are connected to a Could License Server in a
VoiceConsole SaaS Deployment.
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Definition

Entitlement
(License
Header)

Features

Honeywell
Software
Licensing Portal
(HSLP)

Initial License

Legacy Licenses

License
Administrator

Offline Device

An Entitlement is a combination of a Sold To (partner) and a Ship To (end
customer) OR direct customer (same Sold To and Ship To). This means
that a single entitlement for a partner and end customer combination can
store and manage multiple licenses in one place. This system allows for
easier organization and management of licenses.

Entitlements are created based on Ship To details. Customers wanting
flexibility to use licenses across all their different sites should submit
Purchase Orders (POs) using the same Ship To address so there is a single
entitlement.

VoiceConsole On Prem deployment licenses can be consumed from one
entitlement to another entitlement within same customer group.

VoiceConsole SaaS deployment licenses cannot be consumed from one
entitlement to another entitlement, hence why having one entitlement per
customer group provides flexibility in this scenario. For this reason, it is
important to establish the correct quantities when placing a purchase
order (PO) to avoid the need to move licenses from one entitlement to
another.

Each SKU is a collection of related features

Honeywell Software Licensing Portal is the licensing tool for Voice
Partners and Direct Customers to receive, view, activate and return
licenses for VoiceConsole 6.2 and later.

An initial license is a brand-new Entitlement (license header) and
Activation ID (license key)

Legacy licenses are supplied by Honeywell but do not use the HSLP.
VoiceConsole versions earlier than 6.2 require legacy licenses.

Legacy licensing is deprecated for VoiceConsole 6.2 and use of this
licensing system requires special approval from Honeywell.

This person is a member of the Sold To organization. The Sold to
organization is either a Honeywell partner or a direct customer of
Honeywell. This person is responsible for all license tasks within the
Honeywell Software Licensing Portal. This person receives the Cloud
Server ID from Honeywell via email.

For VoiceConsole On Prem deployment only - the VoiceConsole server
does not maintain a continuous internet connection to HSLP.
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Definition

Parent
Activation ID

Renewal license
(replacement)

Ship To

Sold To

Upsell license
(replacement)

VoiceConsole
Administrator

VoiceConsole
On Prem
Deployment

VoiceConsole
SaaS
Deployment

When an Upsell or Renewal license is created, it is given a new Activation
ID. The original Activation ID is now referred to as the Parent Activation ID.

An Renewal license is a license that extends the subscription expiration
date. The previous license is replaced by the Renewal license.

A new Activation ID is issued for the Renewal license and the original
Activation ID is now the Parent Activation ID.

The user of VoiceConsole. If purchased through a Honeywell partner, this
is the customer using VoiceConsole. For a Honeywell direct customer, the
Ship To and Sold To are the same.

The purchaser of VoiceConsole. This can be a Honeywell direct customer
or a Honeywell partner.

An Upsell license is an upgrade to a higher version of the product, such as
upgrading from VoiceConsole_Core to VoiceConsole_Pro. The previous
license is replaced by the Upsell license.

A new Activation ID is issued for the Upsell license and the original
Activation ID is now the Parent Activation ID.

This person is a member of the Ship To organization. The Ship To
organization is either a direct customer of Honeywell or an end customer
of a Honeywell partner. This person is responsible for all license activities
within VoiceConsole. This person receives the Activation ID (VoiceConsole
On Prem deployment) or Cloud Server ID (VoiceConsole SaaS deployment)
from the License Administrator.

VoiceConsole On Prem deployments are managed by the customer. The
deployment may be on a local server or on a cloud instance managed by
the customer. This deployment type uses offline activation mode, also
known ss local licensing within VoiceConsole.

VoiceConsole SaaS deployments are managed by Honeywell in the cloud.
This deployment type connects directly to HSLP.
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Contact Us

Voice Customer Service

Contact our regional VoiceConsole Customer Service Team should you have any general
questions about your HSLP access, order or the license provided to you.

North America, Latin VoiceCustomerServiceAmericas@Honeywell.com +1(866)862-
America 6553
Europe, Middle . . +44 16989
e, ke Al VoiceCustomerServicecEMEA@honeywell.com 15777
Japan csjapan.pss@honeywell.com +81-3-6730-
Brazil ACSHSMCentraldepedidos@honeywell.com vED 9

P ywes 36299000
Asia Pacific VoiceCustomerServiceAPAC@honeywell.com 1?;;‘76989

Voice Technical Support

Contact our Technical Support Team should you have more technical questions about Voice
products or license issues.

Americas VoiceTechnicalSupport@honeywell.com +1(866) 862-7877
Europe, Middle East, . . +44 (0) 1344-65-
Africa VoiceTechnicalSupport@honeywell.com 6123

Rest of World VoiceTechnicalSupport@honeywell.com +1 (412) 376-9384
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CHAPTER

USER ACCOUNTS

There are two types of user accounts within the Honeywell Software Licensing Portal.

e General user - This user has full access to all functions and screens displayed within this
document. This is the user role granted to partners and Honeywell direct customers by
Honeywell.

e Self-registered user - Users can register themselves on the Honeywell Software Licensing
Portal by providing an Entitlement ID. A self-registered user can only view the details of
the entitlement they used when registering. Self-registered users fall into two groups:

° Partners and Honeywell direct customers who need immediate access to HSLP.
These users can contact Voice Customer Service to upgrade to a general user.

° End customers of partners may be provided an Entitlement ID to self-register with
HSLP. These users cannot be upgraded.

First Time User

Do you have a registration email?

If you have a registration email with your account details and password, follow the login process
on the Registered User section.

| don't have a registration email
Honeywell has preregistered many new users in the Honeywell Software Licensing Portal.

To see if you are preregistered, follow the Password Assistance procedure. Allow up to five
minutes for the password reset email to arrive.

| didn't get a password reset email, but | have a license email

If you did not get a password reset email after five minutes, first check any junk mail or spam
filters.

If you still do not have a password reset email, but you do have a license email with an
Entitlement ID, you can register for limited access using the Entitlement ID. This method
provides instant access to HSLP.

See Self-Registered User for details on this process, including the limitations of this method.
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| didn't get a password reset email, and | don't have a license email

If you did not get a password reset email after five minutes, first check any junk mail or spam
filters.

If you still do not have a password reset email, it is necessary to register as a new user.

¢ Contact your regional Voice Customer Service team. They request creation of your User ID
and provide login details via email. Please allow up to 24 hours turnaround.

After receiving the email confirming the registration, follow the Registered User process.

I'm a partner and | want my customers to handle the license activation process

If you are a partner, you can elect to have your users handle the entire licensing process. To do
this provide the Entitlement ID to the customer and have them follow the Self-Registered User
process.

IMPORTANT
If you use this process, for security purposes follow the Remove User Access if the person

associated with the account leaves the company.

Additional Users

Please ensure all employees installing software licenses for customers have access to Honeywell
Software Licensing Portal at least 24 hours before the go live date.

e Contact your regional Voice Customer Service team to add additional users, or

e Use the Register Other Users procedure to add additional employees.

IMPORTANT
If you use this process, for security purposes follow the Remove User Access if the person

associated with the account leaves the company.
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Self-Registered User

There are two instances where you may need to self-register as a user:

* You are a direct customer or a partner but don't have a registration email and an attempt
to recover the account with the Forgot Password link did not work.

¢ You are a VoiceConsole On Prem deployment customer who purchased your Voice product
through a partner and the partner wishes for you to handle the entire licensing process.

NOTE

This process provides limited access for users that have an Entitlement ID. This process
only grants access to the Entitlement ID used when registering. If you are a partner or a
Honeywell direct customer, you can contact Voice Customer Service to upgrade to full
access. If you are a customer of a partner, this process provides details to your entitlement
only.

e Partners with multiple Entitlement IDs need to contact their regional Voice Customer
Service team to be upgraded to full access to view multiple Entitlement IDs.

e Partners who wish for their customers to manage licenses must provide the Entitlement ID
to the customer for VoiceConsole On Prem deployments. For VoiceConsole SaaS
deployments, the partner provides the Cloud Server ID and the end customer does not
need to register with HSLP.

To self-register:

1. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be

configured to allow pop-ups.

2. Click on the Register link.
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Honeywell

Login
{®) With User Name

) with Entitiement ID
(") With Activation 1D

English (United States)

Forgot password?  Regisler -

3. The registration page is displayed.
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11

*

Register for Account

Fill gut the required fizlds to register a new usar.

Registration Details
Entitlement/Activation 10°
First Name*
Lasl Name*
Email Address*
# Company*
Fhone
Fax

Sireat

City
State/Province

ZipfPostal code

Country  United States b
Locale  English (United States) i
Time Zong  (GMT -8.0) Pacific Time v

Opt in to receive email 0 Yes @® Mo

IMPORTANT
Honeywell recommends using a corporate address. Free email accounts such as

Gmail.com, Yahoo.com, and similar may be purged from the Honeywell Software
Licensing Portal for security purposes.

4. Click Complete.

5. Watch for a registration confirmation and instructions to reset the password.
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Honeywell

Dear Vouce User

You now have access to the Honeywell Software Licensing Portal, where yvou can view vour Entitlements,
Activation IDs, Devices and download the license file.

To get started:

1. Usze thic UEL to set vour password

2. Enter vour email Voice.Useri@email.com

3. You will receive another email with a temporary password and further instructions

Best Regards,
Heonevwell Software Licensing Portal

Home Page | Your Privacy |

6. When this email arrives, follow the link or return to the login screen above. Follow the
Password Assistance procedure to receive a temporary password and set your password.

Honeywell Software Licensing Portal User Guide
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Honeywell

Dear Voice User,

This email has been sent to vou because vou requested a password reset. Use the following information to login to
the Honeywell Software Licensing Portal:

Login: Voice.User{@email.com
Temporary password:  XXXXXXXLAXXTLAAX
Login URL hitps:/honeyvwellsps-fno. flexnetoperations. com flexnet/operationsportal logon.do

After vour mmitial login, vou will be promptad to change this password.

! Warning: This temporary password expires shortly

Login as soon as you recerve this email If temporary password expires, select the "Forgot Password" link on
the login page

Best Regards,

Honeywell Software Licensing Portal

Home Page | Your Prvacy |

Register Other Users

If you are a general user, you can register other users from your organization within the
Honeywell Software Licensing Portal.

1. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

2. Click on Accounts & Users.

Honeywell

License & Delivery P{ AEEES THIETS

Manage Access Tokens

Recent Entitlements.

3. Click on List Users. The existing users are displayed in the table.
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Honeywell

Users

Users are listed below. Sort by clicking the column heading. Click specific items to view details or edit them

Page 1 oft

Display name v Contains v @ Advanced Search Q
(] Display name Username Email address Type
0 user ot User_01@emailcom User_01@emailcom User
[ ser0z User_c2@emailcom User_G2@emailcom User
[ User 03 User_oagemailcom User_cagemailcom User

4. To create a new user, click Actions > Create.

Honeywell

Users

Users are listed below. Sort by clicking the column heading. Click specific items to view details or edit them

Actions ~

Create .

Display name v Contains v © Advanced Search Q

(] Dispiay name Username Emailaddress Type
O Userot User_01@emailcom User_01@emailcom User

User 02 User_02@emailcom User_02@emailcom User
(m)
O Usero3 User_oagemailcom User_cagemailcom User

5. Complete the entries for the new user.

Honeywell

Voice User ¥

Create User

Enter the user details below. Click Save to create the user.

User Info Contact Info
Canthis user oginto @ Yes () No

Street
FlexNst Operations? *

Shared Login: () Yes g No

Status: g Active (- Inactive

First Name* City
Last Name* State/Province
Time Zone  (GMT -5.0) Eastern Time ) ZipiPostal Code
Email Address® Couniry  United States v
Optin toreceive email () Yes @ No Locale  English (United States) v
Phone.
Fax

Accounts
Actions v

i Linkaccounts ‘Account name

Remove
No accounts linked to this user.

Save Cancel

* An asterisk indicates a required field. Others are optional.

e Honeywell recommends creating individual users rather than using Shared Login. If

you use Shared Login, it is your responsibility to remove access to shared users if
they leave your company.

6. An account and role must be assigned to the new user. Click on Actions > Link accounts.
The Select Accounts window pops up.

Select an account from the list and then select a role. For the role, select Portal Admin
User Role. Click OK.
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Select Account

Select an account from the list of accounts below.

Page 1 of1 Account ID ~ Contains ~ QQ Advanced Search
Partners
[[] Account 1D Account name City State Gountry Role
12345678 Voice Customer Co United States
- O fat O fum
7. This completes the entries on the user screen. Click Save.
Honeywell Userv.

Create User

Enter the user details below. Click Save to create the user.

User Info Contact Info
Canthisuserloginto @ Yes (- No Strest
FlexNet Operations? * -
‘Shared Logir @ No
Status: @) Active (- Inactive P
First Name* City
Last Name* StaterProvince
TimeZone  (GMT -5.0) Eastern Time v Zip/Postal Code
Email Address® Country  United States v
Optin toreceive email () Yes @ No Locale  English (United States) v
Phone
Fax
Accounts
] AccountID. Account name. Role.
O 12a4s67 Voics Custamer Co

O Portal Read User Role

Save Cancel

Registered User

1. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.
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Honeywell

Login

{®) With User Name h

") with Entitiement ID
) With Activation 1D

English (United States) w

Forgot password?  Register -

2. Login using your email address and the password received in the licensing email.

IMPORTANT
The only supported login for the Honeywell Software Licensing Portal is With User
Name. The other login options are not currently available for this portal.

If you have difficulty with the login, check HSLP Access Troubleshooting or contact your
regional Voice Customer Service team. They can check if you are preregistered as a User. If
not, they can create your ID and provide details via email within 24 hours.

3. Once successfully logged in to Honeywell Software Licensing Portal, the home page is
displayed.

Honeywell

License & Delivery Portal

Recent Entitlements. Announcemen its
Pr
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Edit the user profile by clicking on the down arrow by the username in the upper right corner of
the screen.

Honeywell

Home.

Entitlements

Edit User Profile

Edit profile details for his user

Profile Details Contact Info
Use @honeywell com Street
Fir
s
s
voicecustomer@honeywell.com cy
@M OYes
= - State/Province:

Zip/Postal Code:
Fax

Country:  United States

Date Created: Sep 23, 2024

Locale:  English (United States)

Date of Last Login®: Oct 1,2024
Time Zone:  (GMT 5.5) India Standard Time

< ¢ <<

Account  DEMO

The Locale field specifies the language of the HSLP interface. Only English is supported
currently.

The default time zone is India Standard Time. This can be set as desired.

17 Honeywell Software Licensing Portal User Guide



Security

Click on Security from the User Profile screen.

Security Q

2 Password
Change your password 10 protect your account

C Security Question
Choose a security question and answer to resat your password yourseli if you forget i

Cancel

This screen provides options to:
¢ Change your password.

¢ Set security question - set a security question and answer in case a password reset is
needed.

Password Assistance

If you forget your password, follow this process to recover.

1. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.

2. Click on Forgot Password.
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19

Honeywell

Login

{®) With User Name
") With Entitiement 1D
(") With Activation 1D

English (United States) w

3. Enter your email address as your User ID and click Continue.

Password Reset

To reset vour password, you will nead 1o follow these two sleps:
(a) Enter your User Id
(b) Answer the securlty guastion

Usger Id*

Continue Cancel

If you are a registered user in the Honeywell Software Licensing Portal, a temporary
password is emailed.

4.
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Honeywell

Dear Voice User,

This email has been sent to vou because vou requested a password reset. Use the following information to login to
the Honeywell Software Licensing Portal:

Login: Voice.User{@email.com
Temporary password:  XXXXXXXLAXXTLAAX
Login URL hitps:/honeyvwellsps-fno. flexnetoperations. com flexnet/operationsportal logon.do

After vour initial login, you will be prompted to change this password,

! Warning: This temporary password expires shortly

Login as soon as you recerve this email If temporary password expires, select the "Forgot Password" link on
the login page

Best Regards,

Honeywell Software Licensing Portal

Home Page | Your Prvacy |

5. If you do not receive an email with a temporary password within five minutes, review check
HSLP Access Troubleshooting or contact your regional Voice Customer Service team.

6. Login using your email address and the temporary password from the email.

7. To change password, enter your temporary password and enter your new password.
Confirm the new password in the following field. Click on Continue.

Change Password
Pasaword”
Mew Password®

Confirm Mew Password®

8. Select a preferred secret question and fill in your answer. Then click on the Continue
button. Optionally you can update the security question as well.
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o Flease enter the secrel angwer,

Change Password

Please change your password,

Pasggard: * seeessrrensarens
Mew Password: * seesssssssssees

Confirm Mew Fassword: = st

Please enter the secret question and answer for recalling your password.
Changing of secret gquestion and answer Is optional for exdsting user. If not specifled, the existing secret question / answer will be preserved.

Secret Question: * N what city or town was your first job? v

AMEWET

Remove User Access

Partners using the Honeywell Software Licensing Portal are responsible for managing their
users. Honeywell recommends deactivating accounts (removing user access) when an employee
leaves the organization. This could be an employee of the partner, an employee of a company
that bought directly from Honeywell, or an employee of an end customer that was granted
access by the partner.

Removing Access from an End User's Account

If a partner has granted access to the Honeywell Software Licensing Portal by providing the
Entitlement ID to an end user, the partner is responsible for removing this limited user account.
Contact Voice Customer Service with the Entitlement ID used for the end user. Costumer service
can view any accounts associated with that ID and remove access for the desired account(s).

Removing Access for a User from Your Company

If you are a general user, you can remove other users from your company (either a partner or a
direct customer of Honeywell).

1. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

2. Click on Accounts & Users.
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Honeywell

License & Delivery P {aa

Access Tokens
List account

Manage Access Tokens
lated

Recent Entitlements.

Actication ID Product

3. Click on List Users. The existing users are displayed in the table.

Honeywell

Users

Users are listed below. Sort by clicking the column heading. Click speciic items to view

Page 1 oft

details or edit them.

[ Dislay name.
0 vserot

[ ser0z

[ User03

4. Select the desired user.

5. The Edit User screen is displayed.

Activation & Devices

Entitlements

Edit User

Edit or view the user details below. Click Save to update info.

User Info

Can this user log in to Yoz Mo
FlaxNet Operations? *

Shared Login: —, Yes ® No
Status: -~ Actve g, Inactive
LW L
6. Change Status from Active to Inactive.
7. Click Save.

8. The user's access to the Honeywell Software Licensing Portal is disabled.
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CHAPTER

DEVICES

From the Home page, select Devices > Devices. The Devices list is displayed.

Honeywell

Devices
M 4 1 50076 b 50 v perpage Y Devicename ~ Widcard alowed o EEn
< e < L

Name <o

LastModfied 1
12345678ABCD 12345678ABCD (ETHERNET) Lcenselnfo  Sep 27,2024
00000000002 0000000CXD2(STRING|

300000000401 300000000001 (STRING) Licenseinfs  Sep 11, 2024

00000000003 X0000000CXOIV(STRING:

The device list displays the following information:
* Name: The device name.
° By default, these devices are the servers running VoiceConsole.

® For a Local License Server (VoiceConsole On Prem deployment) the Device
ID is the MAC address of the server.

® For a Cloud License Server (VoiceConsole SaaS deployment) the Device ID is
the Cloud Server ID

° The filter can also be adjusted to show served devices. Served devices are the voice
devices (Talkman and Android devices) connected to a VoiceConsole SaaS
deployment. For these devices the device name from the VoiceConsole View Devices
page is shown.

¢ ID: The Device ID is similar to the Device Name, but for license servers includes an
indications of server type (STRING if a Cloud License Server or ETHERNET if a Local
License Server).

e Type: Indicates the type of device. Valid types are Local License Server, Cloud License
Server, and Served Devices. Served Devices are the Voice devices connected to a Cloud
License Server. Voice licenses do not include Standalone Devices, but they may be
displayed if you have licenses for other Honeywell products.

¢ Account: This is the Sold To or end user account information for the license.

¢ Licenses: Hovering over these links shows the license detail, including quantity and
expiration.

* Last Modified: The last time the license was modified. Modifications include activation or
deactivation of the license.

23 Honeywell Software Licensing Portal User Guide



Click on the desired device in the list. The View Server page opens.

Honeywell

View Server

License Server ID - AAAAAAAAAAAA

IDType  ETHERNET

Account:  Customer_Test (Customer_Test1)
Server Status : ACTIVE

5 not include any pre-installed licenses.

Product Actvation ID Status Qty mapped Expiration Owner Expiation Status

111 U 2 Sep 52025 EndCustomer_1 Active

The detail includes information about the server including the server ID and name, site name,
and account.

Local License Server shows ID Type = ETHERNET. For Cloud Server ID, the line is replaced by
Auto Provisioned = Yes.

A table displays the license associated with the server and details about those licenses.

From the View Server page, click View > View History. The table shows the history for this server.

From the View Server page, click View > View Served Devices. For Cloud License Server, the
connected licensed Voice devices for that server are shown. This list does not show devices for a
Local License Server.

Filtering the Device list by Served Devices displays a list of all served devices (connected

licensed Voice devices). Only voice devices connected to a VoiceConsole SaaS deployment are
listed.

Honeywell

Devices

M4 1 to500f76 B 50 v perpage P Devicename v Wildcard allowed () [ENED

e Account e

00000001 QUUUUL‘]M (STRING) Served Device 00000001 (Demo Account it)
Served b

Name ) Last Modifed

May 26, 2021

00000002 (STRING) Senved Device 00000001 (Demo Account)
BBBEEEEEEE88

00000003 00000003 (STRING) Served Device 00000001 (Demo Account)
Served by CCCCCCCCCCCC

May 26, 2021

May 25, 2021

The list displays the Voice device's name (as assigned within VoiceConsole). The Device ID
column also displays the Cloud License Server through which the Voice device is licensed.
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Click on any device for more details about that device.

Honeywell Voice User¥

View Served Device

Details

Device ID: 100000000
Name: 100000000
Model: FLX_CLIENT
Served Device Status: NORMAL
Last Sync Time: Tue Sep 17 12:44:54 PDT 2024
License Server ID: 333333333333
License Server ID Type: STRING

Account: Voice_Testing
(Voice_Testing)

Notes:
Site Name 2000700000000

Features
Feature Name Version Count ‘Overage Valid Until
GWS_Ent 10 1 0 Tue Aug 18 16:59:59 PDT 2026

Search Devices

There are several search options available from the devices list.

Honeywell Voice User¥

Devices.

Devices i

M4 1 50076 b 50 P Devicename v Wildcard allowed () [EEES
Name <o B © Licenses LastModtied 1
123456784800 12345575ABCD (ETHERIET) Sep 27,2024
00000000002 X000OCKI(STRING) Sep 14,2024
00000000001 0000000001 STRING) Sep 11,2024
000000000X03 X00000OCKDV(STRING) Sep 10,2024

Filter

The first step in searching is to apply the relevant filters. Click on the filter icon to view the filters
being applied.

Dievic

Type
» Slandalone Devices

« Local License Senvers
« Cloud License Servers

B Served Devices

Status
o Aclive

B Inactive

Apply
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Standalone Devices is not used for Voice product licensing. You may see standalone devices in
your list if you have other products licensed through Honeywell. To view only Voice related
licenses, you can uncheck Standalone Devices

You can filter the device list by either Local License Servers (VoiceConsole On Prem
deployments), Cloud License Server (VoiceConsole SaaS deployments), or both.

If you select Served Devices the list includes the Voice devices (both Talkman and Android) that
are licensed via a Cloud Licensing Server in a VoiceConsole SaaS deployment. Devices licensed
via a Local License Server are not included.

There are several items available in the Search pulldown list.

Device name v Wildcard allowed (™) Search |
Device name
| Device 1D

Account Name

Licenses Last Modified

Account [D
Entitlement ID
Activation ID
Product name

Part number

Site Name

Served by server ID

You can search any item in the Search pulldown by selecting your search category and entering
all or part of the search string. Use the wildcard (*) to search on a partial string. Click Search to
perform the search.

Note that for Voice licenses, the Device Name and the Device ID are the same except the Device
ID contains an identifier (String for Cloud License Server and Ethernet for Local License Server).
The Device Name and ID are the MAC address for Local License Servers.

Search by Product Name find the servers that are using a specific Product Name or SKU.
Searching by terms such as "VoiceConsole" does not return any results. Instead use the Product
Name found on the license email.

Part number is not used for Voice licenses, so nothing is returned for that search.

When the Device List is filtered, a notice is applied at the top of the screen.

Activation &

Entitlements

Q Results for Device name:; h* Clear
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The notice includes a summary of the search filter applied and a Clear link to remove the search
filter.

NOTE
The Clear function does not reset the filters. It only removes the search criteria.

Click on the + icon to perform an advanced search.

Advanced search X ]

Device name:
Device IDx
Account Name
Account 1D
Entitlement 10
Activation 1D
Product name:
Part number:
Site Name:  *

Served by server I0-

The Advanced Search allows searching for the same criteria as the Basic Search. The difference
is the Advanced Search allows you to search for multiple criteria at the same time. Only those
devices that meet all criteria are displayed.

When the Device List is filtered, a notice is applied at the top of the screen.

Activation & Devices

Entitlements

O Results for Device name: h*, Product name: * Clear

The notice includes a summary of the search filter(s) applied and a Clear link to remove the
search filter.
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CHAPTER

LIST ENTITLEMENTS

From the Home page, select Activation & Entitlements > List Entitlements. The Entitlements list
is displayed.

Honeywell

List Entitlements

Entitiements are listed below. Sort by clicking a column heading. Select specific entitiements to view or perform actions on them.

Page 1 Y Activation ID v Contains v Q € Advanced Search

[ [wpe Activation ID Entitement D

ol

OB

OBE® s23% 000ccoocooocooonoo. dcdedclededeactedciedote )
oooconcs o skeade &

3000000000000000C 10 0 100 Nov 9, 2024

The Entitlements table contains the following information:

Type

This is the type of license. All VoiceConsole licenses are identified as Embedded. This indicates
the license is embedded on the device and does not rely on a certificate.

IMPORTANT
This is not to be confused with the embedded database supported in VoiceConsole 6.1 and
earlier.

Icons indicate the special details of the license.

B The license is an upsell. This new Activation ID with additional features replaces an older
Activation ID.

The license is a renewal. For subscription licenses this new Activation ID has the extended
subscription start and expiration dates.

Activation ID

The Activation ID is used to activate VoiceConsole On Prem deployment licenses. For each
purchase order submitted, you receive a new Activation ID via email which includes the quantity
of licenses purchased.
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The Entitlement ID is a unique identifier for a combination of a Sold To (partner) and a Ship To
(end customer) or direct customer (same Sold To and Ship To). This means that a single
Entitlement ID may have multiple Activation IDs.

This identifies the customer using VoiceConsole.

This indicates the products included in the license. Contact customer service for details.

The version column does not reflect the version of VoiceConsole that is licensed. This column is
to be ignored.

The available copies of the license that remain to be activated.

For a VoiceConsole SaaS deployment, all copies of the license are always activated and this
column shows zero. To see the available copies of the license after activation, it is necessary to
use the View License function within VoiceConsole.

For a VoiceConsole On Prem deployment, this column represents the maximum copies that can
be requested for activation.

This column represents the total copies of the license.

End date for a subscription license or Permanent for a permanent license.

There are several options available from the entitlements list. At any time, you can clear the
search results by clicking the X icon. This clears the search results but does not affect any filter
applied.
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Honeywell Voice User¥

List Entitlements

Entitiements are listed below. Sort by clicking a column heading. Select specific entitiements to view or perform actions on them.

Page 1 T Activation ID v Contains v Q @ Advanced Search
0 Type Activation D Enlement ID sodto Product Version Available quantty ot Expiration Maintenance
quantty
0000000002000 0 o 100 Seps,2025

o 1

-0 tata-1ata

000000000000000C 10 o 100 oct9, 2024

OB

To00000K 2020-2020

000000000000000C 10 o 100 Novs, 2024

00000k 3c3c-3cic

Filter
The first step in searching is to apply the relevant filters. Click on the filter icon to view the filters
being applied.
Activatic
+ Show fulfilled line iterms
B Show expired line items

+ Show unexpired line idems

Apply

Basic Search

There are several items available in the pulldown list.

Y Entitlement 1D w Co
—- Change search scopa —

Entitlernent ID

Parent bulk entitlement |D
Activation 1D

Product

Part number
Sold-to Account Name
Sold-1o Account ID

NOTE
Parent bulk entitlement ID and Part number are not used for Voice licenses. Searching for
these items does not return any results.

Next select the type of search.
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+ Contains w

tity Equals

Starts With

Ends With

Enter the search text and clock the search (magnifying glass) icon.

TIP

To make searching for special licenses easier, Honeywell prefixes trial and failover licenses.
To search for these types of licenses, search by Activation ID, set the type of search to Starts
With, and enter either trial (for trial licenses) or backup (for failover licenses) and click the
search (magnifying glass) icon.

Advanced Search

Entitlements Advanced Search

Please enter values for significant alfributes and dlick Search o perform an advanced search,

Entitlement Attributes

Entilement ID:  Containg
Activation ID: Contains  +
Parent bulk entitiement ID: Containg v
Product rame: Contains w
Froduct version: Contains v
Product type: A
License technology: Contains

Part number: Containg  w

-

There are several categories available within the advanced search. Many of these do not apply to
Voice licenses, such as product version. Searching for these items does not return any results.

The Advanced Search allows you to search for multiple criteria at the same time. Only those
devices that meet all criteria are displayed.
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Custom Attributes Search

At the bottom of the Advance Search page is the Customer Attributes search.

Partner lier name; Any w

Account Name:  Contains w

Custom Attributes 3 Add

v Contains v B8

Search Clear Cancel

Many of the available search options have no effect on Voice licenses. One that is useful is
searching by PO_Number which is available from this list.

Click + Add to search for multiple criteria and X to remove the criteria from the list. Click Search
to view the results.

Export Entitlements

You can export a list of entitlements to a csv file.

Honeywell Voice User¥

List Entitlements

Entitiements are listed below. Sort by clicking a column heading. Select specific entitiements to view or perform actions on them.

Eor -
Export Selected Items
Export Al tems

Page 1 Y Activation ID v Contains v Q € Advanced Search

O [wpe Entitement D Soldto Product Version Avaiable quantiy o B Maintenance:
aua

000000000000000C 10 o 100 sep5.2025

1 fototateta
o B 1ata-Tala

000000000000000C 10 o 100 oct9, 2024
o000k 20202626,

000000000000000C 10 o 100 Novs, 2024
1000000 3e3c-3c3c

You can export all entitlements or you can select one or more entitlements and export those
selected items.
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CHAPTER

LICENSE MANAGEMENT

The Honeywell Software Licensing Portal (HSLP) is used for licensing VoiceConsole 6.2. and
later.

Prerequisites to activating a license in Honeywell Software Licensing Portal:

1. Voice Partner or Direct Customer contact should be preregistered as a User on the
Honeywell Software Licensing Portal. If you are not, see First Time User. If you need further
assistance, contact your regional Voice Customer Service team. Please allow up to 24
hours for new user requests.

2. Users should have received an automated email from ACSHSMLicense@Honeywell.com
with details of their purchase order and associated license activation details before trying
to login to Honeywell Software Licensing Portal (HSLP). Email samples are included in
Sample License Emails.

There are three email templates as detailed below,
1. New License - For new entitlement with Activation ID (license) Perpetual or Subscription
2. Revision License — For Add-On, Renewal, and Upsell licenses

3. Trial or Demo License - For trial or demo licenses that not associated with a purchase
order

Users should know which type of deployment (SaaS or On Prem) is required per purchase order
or per customer, as this determines which process is used to activate the license. The
deployment type is requested before the purchase order can be processed.

The user must have access to their VoiceConsole instance:

e For VoiceConsole SaaS deployments, the URL to access VoiceConsole is provided via an
email. Follow the details to log onto VoiceConsole.

e For VoiceConsole On Prem deployments, users must have installed VoiceConsole on their
own and have their credentials (username and password).

For online help see https://help.honeywellaidc.com/Software/VoiceConsole/Content/Console_
Home.htm and review the Getting Started section

NOTE
Customers must be aware of their VoiceConsole deployments type as the process differs.
Also, they may not see the licenses in HSLP if they filter by the wrong type.
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The process to license VoiceConsole is summarized below.
VoiceConsole On Prem deployment summary:
For the detailed process see Activate License - On Prem Deployment in the next section.

1. Generate License Activation request file in VoiceConsole by providing the Activation ID and
guantity of licenses (copies) to be activated.

2. Upload License Request file to Honeywell Software Licensing Portal.
3. Download License Response file from Honeywell Software Licensing Portal.

4. Import the License Activation Response File in VoiceConsole to activate software license
(s).

NOTE
The VoiceConsole server requires an internet connection while uploading Activation
Request and downloading License Response.

VoiceConsole SaaS deployment summary:
For the detailed process see Activate License - SaaS Deployment in the next section.

1. Provide Cloud Server ID in VoiceConsole to activate software license(s).

NOTE
VoiceConsole requires an internet connection to activate your license.

In the following sections, it is important to recognize the two roles.

» The License Administrator is a member of the Sold To organization. The Sold to
organization is either a Honeywell partner or a direct customer of Honeywell. This person
is responsible for all license tasks within the Honeywell Software Licensing Portal.

° QOptionally, a partner can elect to have their end customer assume this role. To do
this the partner must provide the Entitlement ID to their end customer and that
customer must Self-Registered User in the Honeywell Software Licensing Portal.

* The VoiceConsole Administrator is a member of the Ship To organization. The Ship To
organization is either a direct customer of Honeywell or a customer of a Honeywell partner.
This person is responsible for all license tasks within VoiceConsole.

For a direct customer of Honeywell, the Sold To and Ship To organization is the same.
In the following licensing sections:

e Any tasks performed within VoiceConsole are performed by the VoiceConsole
Administrator.
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¢ Any tasks performed within the Honeywell Software Licensing Portal are performed by the
License Administrator.

For a direct customer of Honeywell, both administrators are part of the same company.

For a partner of a customer, these administrators are of different companies unless the partner
has elected to have the customer register with the Honeywell Software Licensing Portal.

Activate License - On Prem Deployment

IMPORTANT

If you are a partner activating licenses for multiple customers or a customer with multiple
servers, it is important to make sure not to mix the license request and response files. Each
server generates the same request file (requestfile.bin) and the Honeywell Software
Licensing Portal generates the same response file (capabilityResponse.bin). If the incorrect
response file is returned to a server, there is an error processing the license request.

These files can be renamed after they are generated to avoid confusion.

To perform an initial activation or to activate a greater number of copies of the license, follow
the procedure below.

A new request replaces any previous request. It does not add to the previous request. If 25
copies of the license were activated previously and you now request 35 the total active is 35 (not
60).

If you need to reduce the number of active copies, see Deactivate License (Full) - On Prem
Deployment or Deactivate License (Partial) - On Prem Deployment.

1. Generate the activation request file in VoiceConsole.

a. Login into VoiceConsole with your Username and Password.

Username | |

Password | |

Log into the system

b. From the VoiceConsole home screen, click on the Administration tab.
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Home Administration VoiceConsole

Adminigtration >> Notifications

Notification

Manage Filier

Site Information

[ Default ]

Add or Remove Columns  Copy Selection

Operational Intelligence [

Printable Version

Performance+ [

Application | Process

| Priority «

| Message

Administration

Schedules

Sites

c. Click on Licenses > Configure License.

Home Administration VoiceConsole Operational Intelligence (3

Administration >> License

View Licenses

Manage Filter  Add or Remove Columns  Copy Selecfion  Printable Version

Site Information

Default A

Performance+ [

Date Entered | License Type ‘ License Name

| License Server Location

| License Status

Administration

Users
Roles

Logs
Schedules
Sites.

Audit
Notifications

System Configuration

Software Updates
Export Data

There are no records to display.

d. For On Prem deployments there are two options. Select Local Licensing.

Home Administration VoiceConsole Operational Intelligence (3

Administration >> License >> Configure License

Configure License

Site Information

Default ~

Administration License Options *

Users ) Legacy Licensing

Roles

Logs

@
Schedules \®) | ocal Licensing
Sites
Test Connedtion To Licensing Server

Audit

Motifications

Performance+ [

System Configuration

Save changes Cancel

Software Updates

Export Data

From the License Actions select Activate License.

®

—h

Copy the Activation ID from the license email.

g. Insert the Activation ID and the total license quantity in the Activate license fields as
shown below. The quantity of licenses to activate must be less than or equal to the

total purchased. Click Generate License Request
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Adminisiration >> License >> Activate License
Activate License

Create License Request File

Enter Activatien Id pooo-s0c0t-x000r-00m-n00-000e1000

Number of Copies *

Generate License Request

h. The activation request file (requestfile.bin) is generated and located in your
downloads folder. This file is ready to upload to HSLP.

2. Upload the license activation request file to the Honeywell Software Licensing Portal.

a. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT

When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.

b. After login you are redirected to the HSLP home page.
c. Upload the activation request file (requestfile.bin) as shown below:

i. Click on Devices > Offline Device Management.

Honeywell

Recent Entitlements

ii. Upload the activation request file (requestfile.bin) by selecting the Generate

license or confirm reduction or return, click Choose File to select the correct
file, and click Upload.

Honeywell

Offline Device Management

Manualy upload either a Capabilty Request or Synchronization History Files for offine

Upload type: © Generate lic fcens:
© Upload synchronization histor

Choose File ] No file chosen

Upload
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3. Download the license activation response file from the Honeywell Software Licensing
Portal.

a. Once the activation request file is uploaded successfully, the following notice is
displayed “License has been generated successfully, please click here to download
the new license”.

b. Click the here hyperlink in the message to download the license response file. This
file is placed in your downloads folder and named capabilityResponse.bin.

Honeywell Voice User¥

2
@ ersesoen

Offline Device Management

Manually upload either a Capability Request or offine processing. The application will offer you a response fil to download.

Upload type: @ G
Qu

4. Import the license activation response file into VoiceConsole.

a. Use the Choose File button to browse for the capabilityResponse.bin file and click
Import.

Administration VoiceConsole Operational Intelligence (7 Performance+ [

Administration >» License >> Activate License

Site Information Activate License
[ Default v

Create License Request File

Administration Activation Id is a required field.

Enter Activation Id |

Logs
Schedules Number of Copies *
Sites
Audit
Motifications

System Configuration

Import License Response File

Import License File -
Software Updates P || Choose File | Mo file chosen

Export Data

Import

|mport Data

b. Once the license response file has been imported successfully, a green pop-up
notification shows Successfully activated license file.
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Administration VoiceConsole Operational Intelligence (7 Perfot

J Administration >> License >> Activate License

Site Information

Default hd

Activate License

Create License Request File

Administration Activation Id is a required fisld

Users Enter Activation Id

Roles

Logs

c. To double check license detail, click the Administration tab > Licenses and the
license Activation ID is shown in the View Licenses.

Home Administration VoiceConsole Operational Intelligence [7  Performance+ (7

J Adminisiration >> License

View Licenses

Manage Filter Add or Remove Columns _ Copy Selection Printable Version

Site Information

Default v

Date Issued ‘Actwatmn D |Lmense Type ‘Feamn& Name |Feamr& Count ‘ Start Date |Enu Date ‘ Support Contract Expiry... |

Administration

9/26/24 1:00:00 AM ART Log_Analyzer_Core 100 9/5/24 1:00:00 AM ART 9/12/25 §:59:59 PM ART
Users 9/26/24 1:00:00 AM ART Log_Analyzer_Pro 100 9/524 1:00:00 AM ART 9/12/25 5:59:59 PM ART
9/26/24 1:00:00 AM ART VoiceConsale_Pro 200 9/5/24 1:00:00 AM ART 9/12/25 §:59:59 PM ART

Boles

Deactivate License (Full) - On Prem Deployment

IMPORTANT

If you are a partner deactivating licenses for multiple customers or a customer with multiple
servers, it is important to make sure not to mix the license request and response files. Each
server generates the same request file (requestfile.bin) and the Honeywell Software
Licensing Portal generates the same response file (capabilityResponse.bin). If the incorrect
response file is returned to a server, there is an error processing the license request.

These files can be renamed after they are generated to avoid confusion.

To deactivate a license means to return or remove a license from the customer's VoiceConsole
instance but leave it available within HSLP to be re-activated on the same or another instance of
VoiceConsole belonging to same customer group. The customer still owns the license after it is
deactivated.

NOTE
This process deactivates all copies of the license. See Deactivate License (Partial) to
deactivate only some copies of the license.

Follow the process below to fully deactivate a license.
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1. Generate the activation request file in VoiceConsole.

a. Login into VoiceConsole with your Username and Password.

Username | |

Password | |

Log into the system

b. From the VoiceConsole home screen, click on the Administration tab.

Administration VoiceConsole Operational Intelligence (7 Performance+ [/

Adminigtration >> Notifications

Notification

Manage Filler Add or Remove Columns  Copy Selection  Printable Version

Site Information

[Default ~

Application | Process | Priority - | Message | u}

Administration

Schedules

Sites

c. Click on Licenses > Configure License.

Administration VoiceConsole Operational Intelligence (7  Performance+ (7

Administration >> License

View Licenses

Site Information

[Defaut ]

Defauit ~ Manage Filter Add or Remove Columns Copy Selection Printable Version

—— | patelissued ‘Amva[mn D | License Type ‘ Feature Name | Feature Count ‘ Start Date | End Date ‘ Support Contract Expiry... |
Administration 9125/24 1:00:00 AM ART " Log_Analyzer_Core 100 9/5124 1:00:00 AM ART 9/12/25 8:53:58 PM ART

Users 8/26/24 1:00:00 AM ART Log_Analyzer_Pro 100 9/5/24 1:00:00 AM ART 9/12/25 8:59:59 PM ART

Roles 9126124 1.00.00 AM ART " VoiceGonsole_Pro 200 9/5124 1.00.00 AM ART 912025 5,59.58 PM ART

d. For On Prem deployments there are two options. Select Local Licensing.
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Administration VoiceConsole Operational Intelligence (7  Performance+ (2

] Administration >> License >> Configure License

Site Information Conﬁgure License

Administration License Options *

Users ‘.’ Legacy Licensing

® "
Schedules ‘%) Local Licensing

Test Connection To Licensing Server

Notifications

System Configuration

Save changes Cancel
Software Updates

Export Data

e. From the License Actions select Deactivate License.
f. Locate the Activation ID in the View Licenses table.

g. Insert the Activation ID in the license field as shown below. Click Generate License
Request

Administiration >> License >> Deactivate License

Deactivate License

Create License Request File

Enter Activation ld 0030000000000 0000100041000

Generate License Request

h. The activation request file (requestfile.bin) is generated and located in your
downloads folder. This file is ready to upload to HSLP.

2. Upload the license activation request file to the Honeywell Software Licensing Portal.

a. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.

b. After login you are redirected to the HSLP home page.

c. Upload the activation request file (requestfile.bin) as shown below:
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i. Click on Devices > Offline Device Management.

Honeywell

Accounts &
Users

Offine Device Management

Recent Entitlements. Announcements

ii. Upload the activation request file (requestfile.bin) by selecting the Generate
license or confirm reduction or return, click Choose File to select the correct
file, and click Upload.

Honeywell

Upload type: © Gene
© Upload syn vy

Upload

3. Download the license activation response file from the Honeywell Software Licensing
Portal.

a. Once the activation request file is uploaded successfully, the following notice is
displayed “License has been generated successfully, please click here to download
the new license”.

b. Click the here hyperlink in the message to download the license response file. This
file is placed in your downloads folder and named capabilityResponse.bin.

Honeywell

cessiuly, please

@ oo rasteo

Offline Device Management

Manually upload either a Capability Request or Synchronization

Upload type: ® Gener
© Upload syn

Choose File | No file chosen

4. Import the license activation response file into VoiceConsole.

a. Use the Choose File button to browse for the capabilityResponse.bin file and click
Import.

Honeywell Software Licensing Portal User Guide 44



Administration VoiceConsole Operational Intelligence [ Performance+ [

Administration >> License >> Deactivate License

Site Information Deactivate License
[ Default v

Create License Request File

Administration Activation Id is a required field.
Users Enter Activation Id
Roles
Logs Generate License Request
Schedules
Sites Import License Response File
Audit
Notifications Import License File [ choose Fiie | o file chasen
System Configuration Import

b. Once the license response file has been imported successfully, a green pop-up
notification shows Successfully deactivated license file.

Administration VoiceConsole Operational Intelligence [ Perfol

Administration >> License >> Deactivate License
Site Information

Default hd

Deactivate License

Create License Request File

Administration Activation Id is a required fisld

=
I3
&
e

Enter Activation Id

70
=3
o
tid

[
2
I

c. To double check license detail, click the Administration tab > Licenses and the
license Activation ID is no longer shown in the View Licenses.

Home Administration VoiceConsole Operational Intelligence [Z  Performance+ (3

Administration >> License

View Licenses

Manage Filter  Add or Remove Columns  Copy Selecfion  Printable Version

Site Information

Default hd

Date Entered | License Type ‘ License Name | License Server Location | License Status ‘

Administration

Users
Roles
Logs
Schedules
Sites
Audit There are no records to display.
Notifications

System Configuration

Software Updates

Export Data
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5. Confirm deactivation within Honeywell Software Licensing Portal.

IMPORTANT
At this time, the licenses are deactivated within VoiceConsole, but still show as active

within the Honeywell Software Licensing Portal. To free the licenses it is necessary to
generate the license request in VoiceConsole one more time.

a. Return to the Deactivate License screen within VoiceConsole and enter the
Activation ID in the Deactivate license field. Click Generate License Request

b. The activation request file (requestfile.bin) is generated and located in your
downloads folder. This file is ready to upload to HSLP.

c. Upload the license activation request file to the Honeywell Software Licensing Portal.

a. Access the Honeywell Software Licensing Portal (HSLP) through this link

https://honeywellsps-
fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner

must be configured to allow pop-ups.

b. After login you are redirected to the HSLP home page.
c. Upload the activation request file (requestfile.bin) as shown below:
i. Click on Devices > Offline Device Management.

ii. Upload the activation request file (requestfile.bin) by selecting the
Generate license or confirm reduction or return, click Choose File to
select the correct file, and click Upload.

d. After the file is uploaded, the license is now released and available in the Honeywell
Software Licensing Portal. It is not necessary to download the response file.

Deactivate License (Partial) - On Prem Deployment

IMPORTANT
If you are a partner deactivating licenses for multiple customers or a customer with multiple

servers, it is important to make sure not to mix the license request and response files. Each
server generates the same request file (requestfile.bin) and the Honeywell Software
Licensing Portal generates the same response file (capabilityResponse.bin). If the incorrect
response file is returned to a server, there is an error processing the license request.

These files can be renamed after they are generated to avoid confusion.

To deactivate a license means to return or remove a license from the customer's VoiceConsole
instance but leave it available within HSLP to be re-activated on the same or another instance of
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VoiceConsole belonging to same customer group. The customer still owns the license after it is
deactivated.

This process performs a partial deactivation of the license. At least one copy of the license must
be left active when using this process. To deactivate all licenses, see Deactivate Licenses (Full.
The partial deactivation process is performed by requesting to activate a smaller quantity of
licenses than are currently active. For example, if 100 copies are active, but you want to return
25 copies to be activated elsewhere, you must process a request to activate 75 copies in a
partial reduction. The new activation request replaces the original activation.

Follow the process below to partially deactivate a license.
1. Generate the activation request file in VoiceConsole.

a. Login into VoiceConsole with your Username and Password.

Username | |

Password | |

Log into the system

b. From the VoiceConsole home screen, click on the Administration tab.

Administration VioiceConsole Operational Intelligence [/  Performance+ [

Administration == Notifications

Site Information Notification
[ Default |

Manage Filter Add or Remove Columns  Copy Selection  Printable Version

Application | Process | Priority « | Message | u}

Administration

Logs
Schedules

Sites

c. Click on Licenses > Configure License.
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Site Information

Default v

Administration

Users

Roles

Home Administration VoiceConsole Operational Intelligence [7  Performance+ (2

J Administration >> License

Manage Filter Add or Remove Columns  Copy Selection  Printable Version

Date Issued ‘At‘.twatmn ] |LmenseType ‘Featune Name |Feamre Count ‘ Start Date |End Date ‘ Support Contract Expiry... |

©/26/24 1:00:00 AM ART
9/26/24 1:00:00 AM ART
©/26/24 1:00:00 AM ART

Log_Analyzer_Core 100
100

200

97524 1:00:00 AM ART
9/5/24 1:00:00 AM ART
97524 1:00:00 AM ART

812425 8:59:59 PM ART
9/12/25 5:59:59 PM ART
812425 8:59:59 PM ART

Log_Analyzer_Pro

VoicsConsole_Pro

d. For On Prem deployments there are two options. Select Local Licensing.

Home Administration VoiceConsole Operational Intelligence [  Performance+ (3

Administration >> License >> Configure License

Configure License

Site Information

Default hd

Administration License Options *

Users ) Legacy Licensing

Roles

Logs

®
Schedules 2/ Local Licensing
Sites
Test Connection To Licensing Server

Audit

Notifications

System Configuration

Save changes Cancel

Software Updates

Export Data

e. From the License Actions select Activate License.

f. Locate the Activation ID in the View Licenses table.

g. Insert the Activation ID and the total quantity of licenses you wish to remain active

after the deactivation in the Activate license fields as shown below. Click Generate
License Request

Administration >> Licenss >> Activate License

Activate License

Create License Request File

Enter Activation Id |mmmmxmmm

Number of Coples *

Generate License Request

h. The activation request file (requestfile.bin) is generated and located in your
downloads folder. This file is ready to upload to HSLP.

2. Upload the license activation request file to the Honeywell Software Licensing Portal.

a. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do
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IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.

b. After login you are redirected to the HSLP home page.
c. Upload the activation request file (requestfile.bin) as shown below:

i. Click on Devices > Offline Device Management.

Honeywell

License & Del g

Seeall

Recent Entitlements. Announcements

ii. Upload the activation request file (requestfile.bin) by selecting the Generate
license or confirm reduction or return, click Choose File to select the correct
file, and click Upload.

Honeywell

Offline Device Management

Manually upload either a Capabilty Request or Synchronization History Files for offine processing. The application will offer you a response fie to dovmioad.

Upload type: @ Generate license or confirm license reduction of return
O Upload synchronization history

Choose File | No file chosen
Upload

Download the license activation response file from the Honeywell Software Licensing
Portal.

a. Once the activation request file is uploaded successfully, the following notice is

displayed “License has been generated successfully, please click here to download
the new license”.

b. Click the here hyperlink in the message to download the license response file. This
file is placed in your downloads folder and named capabilityResponse.bin.

Honeywell

Offline Device Management

Manualy upload either a Capability Request or Synchronization History Files for offine procsssing. The application willoffer you a rasponsa fil to Gownload.

Upload type: (@ Generats icenss or confim gense reduction or retum
© Upload synchronization history

Choose File | No file chosen
Upload

Import the license activation response file into VoiceConsole.

a. Use the Choose File button to browse for the capabilityResponse.bin file and click
Import.
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b. Once the license response file has been imported successfully, a green pop-up
notification shows Successfully activated license file.

Administration VoiceConsole Operational Intelligence E Performa
Administration >> License >> Activate License
Site Information Activate License
Create License Request File
Administration Activation Id is a required field.
Users Enter Activation Id

Roles

Logs

c. To double check license detail, click the Administration tab > Licenses and the
license Activation ID is shown in the View Licenses table with the reduce quantity.

VoiceConsole Operational Intelligence (7  Performance+ (7

Site Information

Default ~
Manage Filter Add or Remove Columns  Copy Selection Printable Version

|Ucense Type ‘Feamne Name |Feamre Count ‘ Start Date |Enn Date ‘ Support Contract Expiry... |

Date Issued ‘Amva[mn [}
Administration 9125/24 1:00:00 AM ART " Log_Analyzer_Core 100 9/5124 1:00:00 AM ART 9/12/25 8:53:58 PM ART
9/5/24 1:00:00 AM ART 9/12/25 8:59:59 PM ART

97524 1.00:00 AM ART 912425 8:59:59 PM ART

Users /26124 1:00:00 AM ART Log_Analyzer_Fro 100
5/26/24 1:00:00 AM ART " VoiceGonsole_Pro 200

Roles

5. Confirm deactivation within Honeywell Software Licensing Portal.

IMPORTANT
At this time, the licenses are shown with the reduced quantity within VoiceConsole,

but still show the previous quantity as active within the Honeywell Software Licensing
Portal. To free the licenses it is necessary to generate the license request in
VoiceConsole one more time.

a. Return to the Activate License screen within VoiceConsole and enter the Activation
ID and the total license quantity in the Activate license fields. The quantity of
licenses to activate must be less than or equal to the total purchased. Click Generate

License Request

b. The activation request file (requestfile.bin) is generated and located in your
downloads folder. This file is ready to upload to HSLP.

c. Upload the license activation request file to the Honeywell Software Licensing Portal.

a. Access the Honeywell Software Licensing Portal (HSLP) through this link

https://honeywellsps-
fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner

must be configured to allow pop-ups.

b. After login you are redirected to the HSLP home page.
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c. Upload the activation request file (requestfile.bin) as shown below:
i. Click on Devices > Offline Device Management.

ii. Upload the activation request file (requestfile.bin) by selecting the
Generate license or confirm reduction or return, click Choose File to
select the correct file, and click Upload.

d. After the file is uploaded, the license is now released and available in the Honeywell
Software Licensing Portal. It is not necessary to download the response file.

Activate License - SaaS Deployment

1. Enter the Cloud Server ID to activate the license.

a. Within VoiceConsole click the Administration tab, > Licenses, > Configure License.

Administration VoiceConsole Operational Intelligence [ Performance+ [

Adminigtration >> License >> Configure License

Site Information c onﬁgure License
[ Default ~]

Administration | License Options *
Users \_) Legacy Licensing
Roles
Logs
@ . .
Schedules “2/ Cloud Licensing
Sites
Cloud Server Id *
Audit
Notifications
m Test Connection To Licensing Server

System Configuration

Software Updates
Export Data

Import Data Save changes Cancel

Security Salt

b. The Configure License page is displayed.

c. For SaaS Deployment, select Cloud Licensing and enter the Cloud Server ID from the
license email that you received from ACSHSMLicense@Honeywell.com, into the
below Cloud Server ID field.
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Administration VoiceConsole Operational Intelligence [ Performance+ [

Adminigtration >> License >> Configure License

Site Information c onﬁgure License
[ Default ~]

Administration License Options *

Users ‘! Legacy Licensing

Roles

Logs

@) ) .
Schedules “2/ Cloud Licensing
Sites
Cloud Serverid * OO0

Audit

Notifications:

m Test Connection To Licensing Server

System Configuration

Software Updates

Export Data

Import Data Save changes Cancel

Security Salt

d. Click Save Changes. if prompted, confirm that you want to change license type by
clicking Continue.

e. Click on Test connection to Licensing Server to verify VoiceConsole can connect to
the HSLP licensing server A successful connection is displayed.

Administration VoiceConsole Operational Intelligence [  Performance+ (£

Adminigtration >> Licenge >> Configure License

Site Information c onﬁgure License
[Default ~]

Administration | License Options *

Users \_) Legacy Licensing

Roles

Logs

fi\ . .
Schedules ‘¥ Cloud Licensing
Sites
Cloud ServerId * OOO00000000

Audit

Notifications

m Test Connection To Licensing Server

System Configuration Successfully connected to Licensing Server.

Software Updates

Export Data

Import Data Save changes Cancel

Security Salt
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2. The licenses are now activated. To view details go to the Administration tab > Licenses.

the top right-hand corner of the screen the Cloud Server ID is shown.

NOTE

The Cloud Server ID does not change throughout lifetime of the license. The View
Licenses section lists the latest license details, as shown below,

Administration VoiceConsole

J Administration > License

View Licenses

Site Information
Default ~

Manage Filler _Add or Remeve Columns _ Copy Selection  Printable Version

Operational Intelligence (5  Performance+ [

Date Issued |Ac(iva(ion ]
Administration

| Feature Name ‘ Feature Count | Start Date ‘ End Date

| Support Contract Expiry... ‘

9/26/24 1:00:00 AM ART

Users 9/26/24 1:00:00 AM ART 0008~ =KX XN XXX, | Subscription

Roles 9/26/24 1:00:00 AM ART

Log_Analyzer_Core 100 9/5/24 1:00:00 AM ART /12125 8:58:59 PM ART
Log_Analyzer_Pro 100 9/5/24 1:00:00 AM ART 9/12/25 8:59:59 PM ART

Canceling License

le_Pro 200 9/5/24 1:00:00 AM ART /12125 8:58:59 PM ART

Canceling a license is irreversible. After cancellation, all configurations are deleted. Canceling
means a customer no longer owns the license. Contact your Voice Customer Service team to

cancel a license.

IMPORTANT

Canceling is not the same as deactivation. Deactivation means the license is no longer
active on the user's VoiceConsole instance, however the license can be activated on the

same or another VoiceConsole instance.
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skl HSLP ACCESS
A TROUBLESHOOTING

How can | access the Honeywell Software Licensing Portal?

See First Time User for initial access.

How can | reset my password?

See Password Assistance.

Why are some features/screens unavailable?

You are a limited access user.

e If you are a partner or a Honeywell direct customer, you can contact Voice Customer
Service to upgrade to full access.

¢ If you are a customer of a partner, you have access only to certain portions of the
Honeywell Software Licensing Portal which allow you to manage your On Prem
deployment license. For other details, contact your partner.

What if | get an application error?

If any failure results in an access issue when logging into Honeywell Software Licensing Portal,
please contact the Voice Customer Service team.

o You cannot log in until an administrator reactivates your user name.

Application Error

Error occurred.
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What if | Get Error 400: Bad Request?

If this error occurs, refer to the solution below.

Error 400 - Bad Request

Solution
1. Clear the browser cache and close the browser.
2. Open the browser.

3. Access the Honeywell Software Licensing Portal (HSLP) through this link
https://honeywellsps-fno.flexnetoperations.com/flexnet/operationsportal/logon.do

IMPORTANT
When accessing the Honeywell Software Licensing Portal, your browner must be
configured to allow pop-ups.
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skl HSL.P COMMON QUESTIONS AND
B PROCEDURES

General Licensing Questions

Who is responsible for licensing management?

The responsibility is divided between the License Administrator and VoiceConsole Administrator.

e The License Administrator is a member of the Sold To organization. The Sold to
organization is either a Honeywell partner or a direct customer of Honeywell. This person
is responsible for all license tasks within the Honeywell Software Licensing Portal.

° QOptionally, a partner can elect to have their end customer assume this role. To do
this the partner must provide the Entitlement ID to their end customer and that
customer must Self-Registered User in the Honeywell Software Licensing Portal.

¢ The VoiceConsole Administrator is a member of the Ship To organization. The Ship To
organization is either a direct customer of Honeywell or a customer of a Honeywell partner.
This person is responsible for all license tasks within VoiceConsole.

For a direct customer of Honeywell, the Sold To and Ship To organization is the same.

VoiceConsole SaaS Deployment Licensing
This process is summarized below. For more details see Activate License - SaaS Deployment.

1. The License Administrator activates their account in the Honeywell Software Licensing
Portal.

2. The License Administrator sends the Cloud Server ID to the VoiceConsole Administrator.

3. The VoiceConsole Administrator enters the Cloud Server ID on the VoiceConsole Configure
License screen.

4. VoiceConsole is now licensed.

VoiceConsole On Prem Deployment Licensing

This process is summarized below. For more details see Activate License - On Prem Deployment,

Deactivate License (Full) - On Prem Deployment, and Deactivate License (Partial) - On Prem
Deployment.
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1. The License Administrator activates their account in the Honeywell Software Licensing
Portal.

2. The License Administrator sends the Activation ID and available quantity to the
VoiceConsole Administrator.

3. The VoiceConsole Administrator enters the Activation ID and quantity on the VoiceConsole
Activate License screen.

4. The VoiceConsole Administrator generates the license request file and sends this file to
the License Administrator.

5. The License Administrator imports the license request file into the Honeywell Software
Licensing Portal.

6. The License Administrator receives the license response file and sends it to the
VoiceConsole Administrator.

7. The VoiceConsole Administrator imports the license response file on the VoiceConsole
Activate License screen.

8. VoiceConsole is now licensed.

The Local License Server is used in a VoiceConsole On Prem deployment.

After a license has been activated, go to the Configure License screen in VoiceConsole. Click the
Test Connection to Licensing Server button. If the licensing server is running, a successful
message is displayed.

NOTE

The test button returns an error if a license has not yet been activated. If the following error
message is received "Connection test to Licensing Server failed. Ensure that license is
activated or contact support if issue persists." In this case, the license manager is likely
running so it OK to proceed with the license activation process.

If any other error message is displayed, check that the service is running:
* Flexnet License Server-honeywel is the service on a Windows server.

 flexnetls-honeywel is the service on a Linux server.

NOTE
Please note the spelling of these services is with one "l".

There are three ways to find your activation ID.
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1. The Activation ID is listed on the licensing email.

2. The Activation IDs for On Prem deployment licensing can be found on the List
Entitlements screen. To further refine the list, use the Search Entitlements function.

3. The Activation ID can be viewed from the View Licenses table within VoiceConsole.

Home Administration VoiceConsole Operational Intelligence [7  Performance+ [

J Administration >> License

View Licenses

Site Information

Default v

Manage Filter Add or Remove Columns  Copy Selection  Printable Version

Date lssued ‘Amvanon 1] |L\cer\5eT¥pe ‘Feamre Name |Feamre Count ‘ Start Date |End Date ‘ Support Contract Expiry... |

Administration

6/26/24 1:00-00 AM ART Log_Analyzer_Core 100 9/5/24 1:00:00 AM ART 9/12/25 §:59:59 PM ART
Users 9/26/24 1:00:00 AM ART . Log_Analyzer_Pro 100 9/5124 1:00:00 AM ART 9/12/25 8:59:59 PM ART
Roles 9/26/24 1:00-:00 AM ART Vi Ci le_Pro 200 9/5/24 1:00:00 AM ART 9/12/25 §:59:59 PM ART

The Cloud Server ID is listed on the licensing email. If this is not available, the Cloud Server IDs
for SaaS deployment licensing can be found on the Devices screen. The Cloud Server ID is found
in the Name column.

To further refine the list, use the Search Devices function.

An Upsell license is a replacement license that adds more features, such as an upgrade from
VoiceConsole_Core to VoiceConsole_Pro.

The Upsell license has a new Activation ID. The old Activation ID is now the Parent Activation ID.

To request an upsell license, you mist provide your current Activation ID to Voice Customer
Service. See How Can | Find My Activation ID?

Use the new Activation ID and follow the Activate License - On Prem Deployment process to
access the Upsell features.

Log out of VoiceConsole and back in again to access the Upsell features.

A Renewal license is a replacement license that extends the subscription expiration date.

The Renewal license has a new Activation ID. The old Activation ID is now the Parent Activation
ID.

To request a renewal license, you mist provide your current Activation ID to Voice Customer
Service. See How Can | Find My Activation ID?
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Use the new Activation ID and follow the Activate License - On Prem Deployment process to
view the new subscription expiration date.

Log out of VoiceConsole and back in again to view the new subscription expiration date.

An Add On license is when a user needs more licenses. For example, they have 100 licenses but
now have 150 devices. They could purchase an Add On license for 50. In this case, the original
Activation ID remains active for 100 devices and the new license is activated to cover the
remaining 50 devices.

If a license is an Upsell or Renewal license, the Upsell or Renewal license is a new Activation ID.
The previous Activation ID (before the upsell or renewal) is now the Parent Activation ID.

You must request an Upgrade or Renewal license.
You need your Activation ID for the request. There are multiple ways to find the Activation ID:

* The easiest way to find the Activation ID is to view the license table in VoiceConsole.
However, if the license is fully consumed or has expired, it does not show in VoiceConsole.

¢ Use the List Entitlements screen to find the Activation ID. The Search Entitlements
function can be used to narrow the results.

» Use the Devices screen to find the device by MAC ID (On Prem deployment) or Cloud
Server ID) SaaS deployment. The Search Devices function can be used to narrow the
results. Click on the Device Name to view the Activation ID.

NOTE
Only the List Entitlements method displays both the current Activation ID and the Parent

Activation ID (if any).

1. From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.
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N

From the List Entitlements screen, click on the Activation ID.

w

In the Entitlement Details popup, scroll down to view the License model.

* On Prem Deployment Licensing (LLS) - This is a license for On Prem deployment
and uses the Local Licensing Server in VoiceConsole.

e SaaS Deployment Licensing (CLS) - this is a license for SaaS deployment and uses
the Cloud Licensing Server in VoiceConsole.

1. From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.

2. The license type is indicated in the Expiration column.

e If the column contains a date, the license is subscription and the date displayed is
the end date for the subscription.

e |If the column contains the word Permanent, the subscription is permanent and the
end date for software support can be viewed by clicking on the Activation ID. In the
Entitlement Details window, scroll down to view SoftwareSupport_ContractExpiry.

NOTE
SoftwareSupport_ContractExpiry is always empty for subscription licenses.

1. From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.

2. Select any Activation ID that shows Permanent in the Expiration column.

3. Click on the Activation ID. In the Entitlement Details window, scroll down to view
SoftwareSupport_ContractExpiry.

1. Identify the MAC address of the server. If you do not know the MAC address use an
available command (such as getmac on a Windows server) to list all MAC addresses for
the server.

2. From the Honeywell Software Licensing Portal, select Devices > Devices.
3. On the right side, select Device ID from the pulldown list.

4. In the text box to the right, enter all or part of the MAC address. Enter only the
hexadecimal characters of the MAC address and no separators (-) or (:). The server may
have multiple MAC addresses. Start with the first listed and try each one until results are
displayed.
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5. Click on Search.
6. If nothing is displayed, repeat for any additional MAC addresses for the server.

License Quantity Questions

Why is the available quantity zero for an Activation ID in HSLP?

VoiceConsole SaaS Deployments

The available quantify is always zero within the Honeywell Software Licensing Portal for a
VoiceConsole SaaS deployment (Cloud Licensing). Refer to the View Licenses table within
VoiceConsole to see how many copies of the license remain available.

NOTE

The copies consumed can be determined by subtracting the copies available (Feature
Count) in the View Licenses table within VoiceConsole from the Total Quantity displayed in
the List Entitlements column in HSLP.

VoiceConsole On Prem Deployments

The available quantity is zero if all copies of the license are activated on one or more Local
Licensing Servers.

You can determine which servers have activated the license by following How can | find the
server where an Activation ID is used?

If a license was either fully or partially deactivated, but that is not reflected in the Available
Quantity, see Why are the returned (deactivated) licenses not reflected?

NOTE

The copies consumed can be determined by subtracting the copies available (Feature
Count) in the View Licenses table within VoiceConsole plus the Available Quantity displayed
in the List Entitlements column in HSLP from the Total Quantity. This assumes the
Activation was only used on one server.

Why are the returned (deactivated) licenses not reflected?

When a license is fully or partially deactivated (returned) from within VoiceConsole it requires an
extra step to free up those licenses within the Honeywell Software Licensing Portal. The process
is highlighted below.

1. Generate request in VoiceConsole and upload request in HSLP.

2. Download response and import into VoiceConsole. At this time, VoiceConsole reflects the
license deactivation but HSLP does not.
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3. Generate a second request in VoiceConsole and upload request in HSLP. Now HSLP
reflects the deactivation (return).

See VoiceConsole online help for more information on license deactivation:
https://help.honeywellaidc.com/Software/VoiceConsole/Content/Console_Home.htm.

There are several reasons VoiceConsole may show no licenses available in the View Licenses
table.

» All copies of the license may be consumed. VoiceConsole only displays available copies of
the license.

* The license may not yet be valid. VoiceConsole does not display licenses that have a future
start date.

* The license may have expired. VoiceConsole does not display licenses that have a past end
date.

e An error may have been made during the license request process (On Prem deployments).
If the Honeywell Software Licensing Portal indicated an error (such as an invalid
Activation ID or incorrect quantity) and this error was ignored, VoiceConsole still reports
the license response import as a success though no copies are activated.

In any of these cases, the Honeywell Software Licensing Portal can be accessed to verify the
license details. See How can | filter by Activation ID? to search for the Activation ID.

This section only applies to an On Prem deployment. In a SaaS deployment, all licenses under
the ID are always activated.

To activate more licenses, repeat the Activate License - On Prem Deployment and request a
larger number of licenses than are currently activated.

* The new request replaces any previous request. It does not add to the previous request. If
25 copies of the license were activated previously and you now request 35 the total
available is 35 (not 60).

e The new activation request must be for more than the currently activated copies and
cannot exceed the total available within the Honeywell Software Licensing Portal.

To activate fewer licenses, you must follow the Deactivate License (Partial) - On Prem
Deployment procedure.

* The new request replaces any previous request. It does not add to or subtract from the
previous request. If 35 copies of the license were activated previously and you now request
25 the total available is 25 (and 10 copies were deactivated).

* The new activation request must be for a minimum of one and less than the currently
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activated amount. If you need to deactivate all copies, use Deactivate License (Full) - On
Prem Deployment.

NOTE
In this case, site means different Ship To locations, not to be confused with a site defined
within VoiceConsole.

How this is handled depends on how the license was set up.

In this case the same Activation ID (On Prem deployment with local licensing) or Cloud Server ID
(Saa$S deployment with cloud server licensing) can be shared across the multiple partner sites.
There is no need to "move" a license as all licenses belong to the same Ship To account.

In this case, licenses cannot be "moved" from one Ship To account to another.

* In On Prem deployments (local licensing) if there are unused licenses at Site A, these

o 0k ow

licenses could be activated at Site B.

In SaaS deployments (cloud server licensing) the unused licenses at Site A cannot be used
at Site B.

From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.

In the filter pulldown list, select:

» Sold-to display name - this is the name of the customer (sold-to) it is the portion
displayed in the parentheses. Example 12345678 (ABC corp) - ABC corp is the sold-
to display name.

e Sold-to ID - this is the ID of the customer (sold-to) it is the portion displayed before
the name which is in parentheses. Example 12345678 (ABC corp) - 12345678 is the
sold-to ID.

Select the desired search type: Contains, Equals, Starts With, Ends With.
Enter the search string in the text box.
Click the magnifying glass icon to search.

The results are displayed.
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There are several options available from the devices list. Refer to Search Devices for available
options.

1. From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.

On the right side of the screen select Advanced Search.

The Entitlements Advanced Search window opens.

Scroll down to Custom Attributes.

Select PO Number from the pulldown list.

Select the search criteria: Contains, Equals, Starts With, Ends With.
Enter all or part of the PO number.

Click Search.
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The results are displayed.

1. From the Honeywell Software Licensing Portal, select Activations & Entitlements > List
Entitlements.

In the filter pulldown list, select Activation ID.
Select the desired search type: Contains, Equals, Starts With, Ends With.
Enter the search string in the text box.

Click the magnifying glass icon to search.

S T

The results are displayed.

From the Honeywell Software Licensing Portal, select Devices > Devices.
On the right side, select Activation ID from the pulldown list.
In the text box to the right, enter all or part of the Activation ID.

Click on Search.

o F W N kE

The results are displayed.

This is available only for SaaS deployments.
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1. From the Honeywell Software Licensing Portal, select Devices > Devices.

To find the desired server, either click the filter icon and filter by Cloud License Server or
use the server ID to search.

3. Select the desired server.

From the View pulldown select View served devices.

5. The results are displayed.

This is available only for SaaS deployments.

1.
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From the Honeywell Software Licensing Portal, select Devices > Devices.
Click the filter icon and filter by Served Devices.

To further refine the list, select Device Name from the pulldown.

Select the desired search type: Contains, Equals, Starts With, Ends With.
Enter the search string in the text box.

Click Search.

The search results are displayed.

Click on the desired device name.

The details for the voice device are displayed, including the associated License Server ID.

There are several options available from the entitlements list. Refer to Search Entitlements for
available options.
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APPENDIX SAMPLE LICENSE EMAILS

C

The following are sample emails. Refer to your actual licensing emails for your specific details.
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This template is to support new perpetual and subscription licenses.

Email Subject Example: Your new license for SO#xooxx — PO#xxxx, for Customer XXXX (City
XXXX)

Dear Voice Customer,

Thank you for your recent order of Honeywell Voice software. You can access the personal
Honeywell Software Licensing Portal (HSLP) to manage/activate your licenses. If this is your
first time using the HSLP portal, use this link to create a new password. If you are an existing
user, login to the portal directly here.

Below is a high-level summary of activation process depending on deployment of license (On
Prem or SaaS):

On Prem Deployment Process:

1. Generate License Activation Request File in VoiceConsole by providing the latest
Activation ID (refer to the table below) and quantity.

2. Upload the License Activation Request File to the Honeywell Software Licensing Portal.

3. Download the License Activation Response File from the Honeywell Software Licensing
Portal.

4. Import the License Activation Response File (Generated in step 3) into VoiceConsole to
activate software license(s).

SaaS Deployment Process:

1. Provide Cloud Server ID (mentioned in the below table) in VoiceConsole to activate
software license(s).

Note: VoiceConsole requires internet connection to automatically activate your license.

If you know the process to activate your new Voice software license, use the information below to
do so. If not, see the Honeywell Software Licensing Portal User Guide to guide you through the
required steps.

Order Information

Entitlement ID A-SXXXXXXXX

Order Date Jan 12,2024
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Ultimate Consignee Name SHIP TO End Customer Name

Ultimate Consignee Account ID | SHIP TO Account Number

Ultimate Consignee Address SHIP TO Address

Line-ltem Details

License Software
Deployment Product Product Activation Cloud Server . SO . License L Support
Type Name Description D D Quantity PO Number Number License Type Start Date Ez;z;rat\on Contract
Expiry
XXXX=XXXX~
e XXXX-XXXX~ Not X Apr 30, Apr 30, Apr 30,
4 7
On Prem name description XK Applicable 100 P0O12345 098765 Subscription 2024 2025 2025
XXXX=XXXX
XXXX=XXXX= c
loud
- - Apr 30 Apr 30 Apr 30
SaaS name description OO0 200 P012345 098765 Subscription pr b, pr oY, pr oL,
XXXX=XXXX~ Server Id 2024 2025 2025
XXXX=XXXX

Note: Software SKUs with the same Activation ID do not require multiple activations for On Prem
deployment.

For more information, please see the Honeywell Software Licensing Portal or VoiceConsole
online help upon your first visit to the portal. The Honeywell Software Licensing Portal advanced
features are all explained in the online documentation.

Contact our regional Voice Customer Service Team should you have general questions about
your HSLP access, order or license provided to you.

Functional Region Email Address Telephone
Group
Customer NORTH VoiceCustomerServiceAmericas@Honeywell.c :§66)862—
Service AMERICA,LATAM | om

6553
Customer | o, 0PE META | VoiceCustomerServiceEMEAG honeywellcom | & it 16989
Service 15777
Customer , : +44 16989
Service APAC VoiceCustomerServiceAPAC@honeywell.com 15777
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Customer : +81-3-
Service JAPAN csjapan.pss@honeywell.com 6730-7344
Customer . +55 35
Service BRAZIL ACSHSMCentraldepedidos@honeywell.com 36299000

Contact our Technical Support Team should you have more technical questions on Voice

Products or License issues.

Technical
Support

GLOBAL

VoiceTechnicalSupport@honeywell.com

Americas: +1(866)
862-7877
EMEA: +44 (0)
1344-65-6123
Rest of World: +1
(412) 376-9384
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This template is to support a revised perpetual or subscription license.

Email Subject Example: Your revised license for SO#xoxx — PO#xxxx, for Customer XXXX (City
XXXX)

Dear Voice Customer,
Thank you for your recent order of Honeywell Voice software. You can access the personal
Honeywell Software Licensing Portal (HSLP) to manage/activate your licenses. If this is your

first time using the HSLP portal, use this link to create a new password. If you are an existing
user, login to the portal directly here.

Below is a high-level summary of activation process depending on deployment of license (On
Prem or SaaS):

On Prem Deployment Process:

1. Generate the License Activation Request File in VoiceConsole by providing the latest
Activation ID (refer to the table below) and quantity.

2. Upload the License Activation Request File to the Honeywell Software Licensing Portal.

3. Download the License Activation Response File from the Honeywell Software Licensing
Portal.

4. Import the License Activation Response File (Generated in step 3) into VoiceConsole to
activate software license(s).

Saa$S Deployment Process:

1. Logout and login again to VoiceConsole to automatically reflect the latest revision of your
license(s).

Note: VoiceConsole always requires an internet connection when it’s configured for Cloud
Licensing

If you know the process to activate your new Voice software license, use the information below to
do so. If not, see the Honeywell Software Licensing Portal User Guide to guide you through the
required steps.

Order Information
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Entitlement ID A-SXXXXXXXX

Order Date Jan 12,2024

Ultimate Consignee Name End Customer Name

Ultimate Consignee Account ID | End Customer Account Number

Ultimate Consignee Address End Customer Address

Line-ltem Details

Cloud License Software
Deployment Product Product Activation . SO . License o Support
o Server Quantity PO Number License Type Expiration
Type Name Description ID D Number Start Date Date Contract
Expiry
XXXX-XXXK=
Usage Usage test XXXX-XXXX~ — Apr 30, Apr 30,
On Prem Test product XSO0 1 P0O12345 098765 Subscription 2025 2025
XXXX-XXXX

Note: Software SKUs with the same Activation ID will not require multiple activations for On
Prem deployment.

For more information, please see the Honeywell Software Licensing Portal or VoiceConsole

online help upon your first visit to the portal. The Honeywell Software Licensing Portal advanced

features are all explained in the online documentation.

Contact our regional Voice Customer Service Team should you have general questions about
your HSLP access, order or license provided to you.

Functional Region Email Address Telephone
Group
NORTH
gsrsvti((:):rener AMERICA, VoiceCustomerServiceAmericas@Honeywell.com ;15(5:_366)862_
LATAM
Customer EUROPE, . A +44 16989
Service META VoiceCustomerServiceEMEA@honeywell.com 15777
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Customer . : +44 16989
Service APAC VoiceCustomerServiceAPAC@honeywell.com 15777
Customer . ~ +81-3-
Service JAPAN csjapan.pss@honeywell.com 6730-7344
Customer : ~ +55 35
Service BRAZIL ACSHSMCentraldepedidos@honeywell.com 36299000

Contact our Technical Support Team should you have more technical questions on Voice
Products or License issues.

Americas: +1(866)
862-7877
Technical : . EMEA: +44 (0)
Support GLOBAL VoiceTechnicalSupport@honeywell.com 1344-65-6123
Rest of World: +1
(412) 376-9384
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This template is to support licenses without a purchase order, such as evaluation, demo, trial,
pilot, testing, etc.

Email Subject Example: Your temporary license for Customer XXXX (City XXXX)
Dear Voice Customer,
You can access the personal Honeywell Software Licensing Portal (HSLP) to manage/activate

your temporary license. If this is your first time using the HSLP portal, use this link to create a
new password. If you are an existing user, login to the portal directly here.

Below is a high-level summary of activation process depending on deployment of license (On
Prem or SaaS):

On Prem Deployment Process:

1. Generate the License Activation Request File in VoiceConsole by providing the latest
Activation ID (refer to the table below) and quantity.

2. Upload the License Activation Request File to Honeywell Software Licensing Portal

3. Download the License Activation Response File from Honeywell Software Licensing
Delivery Portal.

4. Import the License Activation Response File (Generated in step 3) into VoiceConsole to
activate software license(s).

SaaS Deployment Process:

1. Provide Cloud Server ID (mentioned in the below table) in VoiceConsole to activate
software license(s).

Note: VoiceConsole SaaS needs internet connection to automatically activate your license
(s).

If you know the process to activate your new Voice software license, use the information below to
do so. If not, see the Honeywell Software Licensing Portal User Guide to guide you through the
required steps.

Order Information

Entitlement ID A-SXXXXXXXX
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Order Date

Jan 12, 2024

Ultimate Consignee Name

End Customer Name

Ultimate Consignee Account ID

End Customer Account Number

Ultimate Consignee Address

End Customer Address

Line-ltem Details

Product
Name

Deployment
Type

Product Activation
Description 1D

Cloud
Server
ID

License Start
Date

PO
Number

SO

Number Quantity

Quantity License Type

Software
Support
Contract
Expiry

License
Expiration
Date

On Prem name

description

XXXX=XXXX

XXXX=XXXX=
XXXX=XXXX~
XXXX=XXXX=

100 P0O12345 098765 1 Subscription | Subscription

Apr 30,
2025

Apr 30,
2025

Note: Software SKUs with the same Activation ID will not require multiple activations for On
Prem deployments.

For more information, please see the Honeywell Software Licensing Portal or VoiceConsole
online help upon your first visit to the portal. The Honeywell Software Licensing Portal advanced
features are all explained in the online documentation.

Contact our regional Voice Customer Service Team should you have general questions about
your HSLP access, order or license provided to you.

Functional Region Email Address Telephone
Group
NORTH
Cus’;omer AMERICA, VoiceCustomerServiceAmericas@Honeywell.com +1(866)862-
Service 6553
LATAM
Customer EUROPE, _ : . +44 16989
Service META VoiceCustomerServiceEMEA@honeywell.com 15777
Customer _ . +44 16989
Service APAC VoiceCustomerServiceAPAC@honeywell.com 15777
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Customer . +81-3-
Service JAPAN csjapan.pss@honeywell.com 6730-7344
Customer . +55 35
Service BRAZIL ACSHSMCentraldepedidos@honeywell.com 36299000

Contact our Technical Support Team should you have more technical questions on Voice
Products or License issues.

Americas: +1(866)
862-7877
Technical : . EMEA: +44 (0)
Support GLOBAL VoiceTechnicalSupport@honeywell.com 1344-65-6123
Rest of World: +1
(412) 376-9384
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